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Preface

Oracle interMedia Annotator is a utility that extracts metadata from audio, image, 
and video sources of certain formats and inserts the metadata, along with the media 
source file, into an Oracle8i database.

Intended Audience
This guide is intended for anyone who is interested in extracting metadata from a 
multimedia file and storing both the metadata and the multimedia file in an 
Oracle8i database. Advanced users who want to write their own PL/SQL Upload 
Templates should be familiar with PL/SQL. Advanced users who want to write 
their own annotation types should be familiar with Java and XML.

Structure
This guide contains six chapters and three appendixes:

Chapter 1 Contains a general introduction.

Chapter 2 Contains installation and configuration information.

Chapter 3 Contains information on using interMedia Annotator to create and 
manipulate annotations.

Chapter 4 Contains information on creating your own annotation types.

Chapter 5 Contains instructions for uploading annotations to an Oracle8i 
database.

Chapter 6 Contains information on using Oracle interMedia Text to query 
stored annotations.
xi



Conventions
In examples, an implied carriage return occurs at the end of each line, unless 
otherwise noted. You must press the Return key at the end of a line of input.

The following conventions are also used in this guide:

Appendix A Contains reference information on supported formats.

Appendix B Contains reference information on annotation attributes.

Appendix C Contains answers to frequently asked questions.

Convention Meaning

    .
    .
    .

Vertical ellipsis points in an example mean that information not 
directly related to the example has been omitted.

. . . Horizontal ellipsis points in statements or commands mean that 
parts of the statement or command not directly related to the 
example have been omitted

boldface text Boldface text indicates either a term defined in the text, the glossary, 
or in both locations; or a window name, button name, menu name, or 
menu item.

monospace font Monospace font in text indicates a code example, a URL, or an 
absolute path name.

< > Angle brackets enclose user-supplied names.

[ ] Brackets enclose optional clauses from which you can choose one or 
none.
xii



Introdu
1

Introduction

This chapter supplies information on Oracle interMedia Annotator, which extracts 
text information (or metadata) from media sources of certain formats and inserts the 
metadata, along with the media source, into an Oracle8i database.

interMedia Annotator makes use of Oracle interMedia.

1.1 Purpose
When managing multimedia data in an object-relational database system, you will 
likely face the problem of how to extract, process, and manage metadata associated 
with your media sources. Metadata, which typically consists of text-based 
information that describes the media source, is usually embedded within the media 
source using a proprietary format, and is therefore not always easily accessible. To 
be able to efficiently manage and use metadata, you must be able to extract it from 
many different types of media sources. After extraction, you must have a consistent, 
accurate representation of the metadata, regardless of the original media source.

You can use Oracle interMedia Annotator to parse a media source, extract its 
metadata, and group the metadata into an organized structure called a logical 
annotation (or annotation). Every annotation is organized as a set of text attributes 
and optional samples. An attribute provides information about the media source, 
either its data format (such as MIME type or format) or data content (such as song 
title or movie director). Samples are multimedia data (such as audio clips or closed 
captions) extracted from the media source.

You can use interMedia Annotator to parse your audio, image, or video files (see 
Appendix A for a list of supported file formats) and extract attributes to build an 
annotation.

interMedia Annotator also creates a separate annotation for each track of the media 
source. For example, for an audio compact disc, interMedia Annotator creates an 
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interMedia Annotator Operations Overview
annotation for the compact disc (CD) and separate annotations for each audio track 
(that is, each song). The annotations for the audio tracks are sub-annotations of the 
audio CD annotation. For a media source containing a movie, interMedia Annotator 
can create separate sub-annotations for the video data and audio data.

You can use interMedia Annotator to insert the annotation along with the media 
source into an Oracle8i database. Once the annotation is in the database, you can 
use Oracle interMedia Text to query the annotation.

1.2 interMedia Annotator Operations Overview
The main functions of interMedia Annotator are to build a logical annotation from a 
media source and to then upload both the annotation and the source file to an 
Oracle8i database. You can then query the media data in the database based on 
information in the annotation.

Figure 1–1 provides an overview of this process.
1-2 Oracle interMedia Annotator User’s Guide
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Figure 1–1 Overview of interMedia Annotator Operations
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GUI Overview
interMedia Annotator performs the following operations:

1. Parse the media source. interMedia Annotator extracts the metadata from the 
source file.

2. Extract samples from the media source. interMedia Annotator can extract a 
sample from the media data (such as a selection from an audio CD).

3. Integrate information from additional sources. Some information that would be 
useful in an annotation is not necessarily included in the metadata. For 
example, audio CD metadata does not necessarily include song names. 
interMedia Annotator can contact an Internet CD database (or CDDB) that 
contains CD information, such as album titles, artists, and song titles, and add 
this information to an annotation. For more information on CDDB, see:
http://www.cddb.com

4. Create a logical annotation. interMedia Annotator combines the extracted 
samples and the metadata, and builds a logical annotation.

Users can edit the annotation at this point. See Chapter 3 for more information.

5. Upload the annotation and the media source to an Oracle8i database. Through 
the interMedia Annotator Preferences window, you specify the location and the 
connection parameters of the Oracle8i database in which you want to store the 
media source and the annotation.

interMedia Annotator will upload the media source and the annotation (in XML 
format) into an interMedia object in the database. interMedia Annotator can also 
upload individual attributes from the annotation into other columns of the 
database. You specify the interMedia object to which you will upload, along 
with the rest of the information to be uploaded, in a PL/SQL Upload Template. 
You can create a template with a text editor or the PL/SQL Template Wizard.

See Chapter 5 for more information on the upload process.

Once you have completed these steps, you will be able to query the information in 
the annotation in order to use information about the media source that cannot be 
directly extracted. You can also build indexes on the information in the annotation 
using interMedia Text.

1.3 GUI Overview
After you install and configure interMedia Annotator (see Chapter 2 for more 
information), run interMedia Annotator by opening either Annotator.bat (on 
1-4 Oracle interMedia Annotator User’s Guide
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Windows NT systems) or Annotator (on Macintosh). The Oracle interMedia 
Annotator window appears (Figure 1–2).

Figure 1–2 Oracle interMedia Annotator Window
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GUI Overview
The main features of the Oracle interMedia Annotator window are the following:

■ Menu bar: The menu bar contains six menus: File, Edit, View, Annotation, 
Database, and Help.

The File menu contains commands to create a new annotation, open an 
annotation, close an annotation, save an annotation, save the Console, and quit 
interMedia Annotator.

For more information on saving annotations, see Section 3.6.

The Edit menu contains a command to open the Preferences window.

For more information on the interMedia Annotator Preferences window, see 
Section 2.3.1 and Section 3.5.3.

The View menu contains check boxes that let you choose whether or not to 
view the three toolbars or the Console.

The Annotation menu contains commands to extract samples from the media 
source, play the media source in the appropriate media player, insert or delete 
an attribute, and insert or delete an annotation. For more information on 
extracting samples, see Section 3.5. For more information on playing media files 
and samples, see Section 3.8. For more information on defining helper 
applications, see Section 2.3.5.

The Database menu contains commands to create and run PL/SQL Upload 
Templates. See Chapter 5 for more information.

The Help menu contains a command to show more information about 
interMedia Annotator.

■ Toolbar: The toolbar consists of three smaller toolbars, the Standard toolbar 
(Figure 1–3), the Annotation toolbar (Figure 1–4), and the Oracle toolbar 
(Figure 1–5).

Figure 1–3 Standard Toolbar
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GUI Overview
The Standard toolbar contains three buttons: New Annotation, Open 
Annotation, and Save Annotation.

Clicking the New Annotation button opens a dialog box in which you choose 
the media source to parse. interMedia Annotator then parses the media source 
and creates a new annotation. See Section 3.1 for more information.

Clicking the Open Annotation button opens a previously extracted annotation.

Clicking the Save Annotation button saves your annotation as an XML file.

Figure 1–4 Annotation Toolbar

The Annotation toolbar contains two buttons: Extract Samples and Play 
Source.

The Extract Samples button extracts samples from the media source. See 
Section 3.5 for more information.

The Play Source button plays the media source in the appropriate media player. 
For more information on playing media files and samples, see Section 3.8. For 
more information on defining helper applications, see Section 2.3.5.

Figure 1–5 Oracle Toolbar

The Oracle toolbar contains two buttons: Generate Template and Upload to 
Oracle.
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The Generate Template button starts the PL/SQL Template Wizard, which 
takes you through a step-by-step process to define a PL/SQL Upload Template.

The Upload to Oracle button opens a dialog box in which you select a PL/SQL 
Upload Template, which uploads your media source and annotation to a 
selected Oracle8i database.

See Chapter 5 for more information.

■ Annotations pane: The Annotations pane contains an expandable list 
containing the hierarchy of annotations and sub-annotations. The types of the 
annotations and sub-annotations are shown in the Annotations pane.

For more information, see Section 3.1.

■ Attributes tab: The Attributes tab shows the annotation attributes and their 
values. You can use the Attributes tab to change attribute values.

View the Attributes tab by clicking the gray Attributes box when the Samples 
tab is visible.

For more information on the Attributes tab, see Section 3.2 and Section 3.3.

■ Samples tab: The Samples tab shows the contents of an extracted sample. It 
shows either the text of a text sample laid out on a timeline or images extracted 
from a QuickTime movie file. It appears in the same panel of the Oracle 
interMedia Annotator window as the Attributes tab.

View the Samples tab by clicking the gray Samples box when the Attributes 
tab is visible.

The Samples tab is not shown in Figure 1–2. See Figure 3–8 for a graphic of the 
Samples tab.

■ Console: The Console displays messages pertaining to the status of interMedia 
Annotator operations. If an error occurs, notification is printed to the Console, 
along with notification of any action that is taken by interMedia Annotator.

■ Status bar: The status bar shows how much of an operation is completed, from 
0% to 100%.
1-8 Oracle interMedia Annotator User’s Guide
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Installation and Configuration

This chapter provides instructions on the installation and configuration of 
interMedia Annotator and additional helper applications.

2.1 Prerequisites
interMedia Annotator is supported on Windows NT 4.0 and MacOS 8.6. Depending 
on your platform, you must have the following components installed:

■ Windows NT 4.0:

– Oracle JDBC Driver for Oracle 8.1.5 or later. The OCI driver is 
recommended, though the Thin driver will work as well.

– Apple QuickTime for Java (included with QuickTime 4.0), if you plan on 
parsing QuickTime files.

■ MacOS 8.6:

– Macintosh Runtime for Java (MRJ) 2.1.4

– Apple QuickTime for Java (included with QuickTime 4.0), if you plan on 
parsing QuickTime files

You must also have access (either local or remote) to Oracle8i with Oracle8i 
interMedia Option.

If you do not have these installed on your computer, install them according to the 
instructions included with each product.

If you have any previous versions of Annotator, you should remove them from your 
machine.
ration 2-1
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2.2 Installation
The following sections provide instructions on installing interMedia Annotator on 
Windows NT and Macintosh.

2.2.1 Windows NT Installation
To install interMedia Annotator on your local Windows NT machine, perform the 
following steps:

1. With your preferred World Wide Web browser, go to the following location: 
http://technet.oracle.com/software/products/intermedia/soft
ware_index.htm

2. Save the Zip file containing interMedia Annotator to your local machine.

3. Extract the Zip file on your local machine.

4. Run setup.bat.

interMedia Annotator will be installed at <ORACLE_HOME>\ord\Annotator, 
where <ORACLE_HOME> is your Oracle home directory.

5. Run Annotator.bat.

If the installation was successful, the Oracle interMedia Annotator window 
will appear (Figure 1–2).

2.2.2 MacOS Installation
To install interMedia Annotator on your local Macintosh, perform the following 
steps:

1. With your preferred World Wide Web browser, go to the following location: 
http://technet.oracle.com/software/products/intermedia/soft
ware_index.htm

2. Save the Stuffit file containing interMedia Annotator to your local machine.

3. Extract the Stuffit file on your local machine.

4. Run Annotator.

If the installation was successful, the Oracle interMedia Annotator window 
will appear (Figure 1–2).
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2.3 Configuration
To configure interMedia Annotator to best use its features, perform the steps listed 
in Sections 2.3.1 through 2.3.5.

2.3.1 Set Connection to the Database
One of the most useful and powerful features of interMedia Annotator is the ability 
to upload media sources and annotations to an Oracle8i database. To connect to an 
Oracle8i database, you must correctly specify the database connection parameters 
by performing the following operations:

1. From the Edit menu, select Preferences and click the Database tab. The 
Database tab of the Preferences window appears (Figure 2–1).
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Figure 2–1 Database Tab of the Preferences Window

2. Enter the necessary information to ensure that you will connect to the correct 
database:

■ If you are using the JDBC Thin driver, your service name must follow the 
syntax <machine-name>:<port-name>:<oracle-sid>.

■ If you are using the JDBC OCI driver, your service name must follow the 
syntax used by Net8. See Net8 Administrator’s Guide for more information.
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3. Click OK to confirm and save the changes.

2.3.2 Create Tables
Before you can upload annotations and media files, your database must contain 
tables that can be used for the storage of audio and video data. If it does not, you 
will need to create these tables.

The following SQL statements will create two sample tables, one for the storage of 
the video data and one for the storage of the audio data. These statements will 
create the tables that are used in the example in Chapter 5:

CREATE TYPE VideoType AS OBJECT (ID    NUMBER,
                                 title VARCHAR2(256),
                                 vsrc  ORDSYS.ORDVIDEO);
CREATE TABLE VideoStorage OF VideoType (ID PRIMARY KEY)
             LOB(vsrc.source.localdata) STORE AS (NOCACHE NOLOGGING);

CREATE TYPE AudioType AS OBJECT (ID    NUMBER,
                                 title VARCHAR2(256),
                                 asrc ORDSYS.ORDAUDIO);
CREATE TABLE AudioStorage OF AudioType (ID PRIMARY KEY)
             LOB(asrc.source.localdata) STORE AS (NOCACHE NOLOGGING);

Although object types and object tables are used in the examples, any relational 
tables with interMedia Audio or Video types can be used for the storage of audio or 
video data.

2.3.3 Check the Proxy Settings
interMedia Annotator can annotate media sources that are available remotely over 
the Internet through the HTTP protocol.

If you are running in a secure environment, you will need to configure interMedia 
Annotator to use your proxy server before you can access the Internet. Configure 
the proxy server by performing the following operations:

Note: All changes that you make in the Preferences window will 
be saved from session to session except the database password. For 
security reasons, you must re-enter the password every session.
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1. From the Edit menu, select Preferences and click the General tab. The General 
tab of the Preferences window appears (Figure 2–2).

Figure 2–2 General Tab of the Preferences Window

2. Enter your proxy server settings in the "HTTP Proxy Server: " and "HTTP Proxy 
Port: " text fields.

3. Click OK.
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2.3.4 Connect to a CDDB
interMedia Annotator can connect to a CDDB to add information to audio CD 
annotations. However, you must contact the administrators of the CDDB in order to 
obtain a license before using CDDB functions; contact them for a license at:
 http://www.cddb.com/developers.html

To change the CDDB URL that Annotator queries for information, perform the 
following operations:

1. From the Edit menu, select Preferences and click the Parsers tab.

The Parsers tab of the Preferences window appears (Figure 2–3).
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Figure 2–3 Parsers Tab of the Preferences Window

2. If "CDDB" is not visible under "AudioCDParser", click the plus sign (+) next to 
"AudioCDParser" to expose it.

3. Enter the port number and host name in the "CDDB Server Port: " and "CDDB 
Server Host: " text fields.
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4. Click OK to confirm and save the changes.

2.3.5 Install Helper Applications
interMedia Annotator is capable of playing media sources and extracted media 
samples. However, in order to play them, you may need to install some additional 
helper applications.

Recommended Windows NT applications are:

■ Microsoft Windows Media Player

■ QuickTime Player

■ RealPlayer

■ WinAmp

Recommended Macintosh applications are:

■ QuickTime 4.0 Player

■ RealPlayer

Make sure that each MIME type is paired up with the correct file extension and 
player by performing the following operations:

1. From the Edit menu, select Preferences and select the Mime-Types tab.

The Mime-Types tab of the Preferences window appears (Figure 2–4).

Note: You must obtain a license from the CDDB server before you 
can use its functions.
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Figure 2–4 Mime-Types Tab of the Preferences Window

2. Double-click on the row of the MIME type that you want to edit.

The Change: Mime-type Settings window appears (Figure 2–5).
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Figure 2–5 Change: Mime-type Settings Window

3. Edit the contents of the window and click OK.

The Change: Mime-type Settings window closes.

4. Click OK to confirm and save the changes.
Installation and Configuration 2-11



Configuration
2-12 Oracle interMedia Annotator User’s Guide



Generating and Manipulating Annota
3

Generating and Manipulating Annotations

interMedia Annotator is packaged along with several sample multimedia files. They 
are included in the ANNOTATOR_HOME\media_data directory. You can use 
interMedia Annotator on these files (or on files of your own choosing) to perform 
several operations. These operations include:

■ Creating an annotation

■ Editing attributes

■ Adding and deleting attributes to the annotation

■ Adding and deleting annotations

■ Extracting samples

■ Saving an annotation

■ Opening an annotation

■ Playing media sources or samples

3.1 Creating an Annotation
To create an annotation, perform the following operations:

1. Either select New from the File menu or click the New Annotation button.

The Make a Selection window appears (Figure 3–1).
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Figure 3–1 Make a Selection Window

2. To create an annotation populated with metadata from a media file, click the 
from Source button and select a media file from the pull-down menu.

If the media file does not appear in the pull-down menu, click the Browse 
button and select a media file in the Open window (Figure 3–2).

Figure 3–2 Open Window
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3. To create an empty annotation, click the of Type button and select an annotation 
type from the pull-down menu. (This option will be used most often in 
conjunction with a user-defined annotation type. See Chapter 4 for more 
information on creating your own annotation types.)

4. Click OK.

See Figure 1–1 for more information on how interMedia Annotator builds an 
annotation.

interMedia Annotator can parse media sources accessible through the URL 
protocols shown in Table 3–1.

If you are parsing a local file or a file available over the Internet through the http 
protocol, interMedia Annotator extracts the time-independent attributes from the 
media file and inserts them into a logical annotation.

If you are parsing an audio CD, interMedia Annotator can connect to a CDDB, find 
the entry corresponding to your CD, and create a logical annotation.

If you are parsing a media source with multiple tracks, such as a video source or 
audio CD, an annotation is created for each track.

When the parsing is complete, the annotation type appears in the Annotation Tree 
View of the Annotations pane. The attribute names and values for the currently 
selected annotation are displayed in the Attributes tab of the interMedia Annotator 
window (Figure 1–2). The Annotations pane contains an expandable list, which 
shows the hierarchy of annotations and sub-annotations (Figure 3–3).

Table 3–1 Available URL Protocols

URL Protocol Description

file Access all the files on local or remotely mounted disks in your 
computer.

http Access media available through an Internet Web server.

cd Access audio compact discs in your local CDROM drive.

Note: The URL used to extract annotations from a compact disc is 
not a standard URL. The URL is defined as follows:

■ Windows NT: cd:<your Windows CD-ROM drive>#cdda

■ Macintosh: cd:#cdda
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Figure 3–3 Annotations Pane with Expanded List

In order to display the attributes of another annotation, select it in the Annotation 
Tree View.

Some JPEG files contain additional metadata in the Information Interchange Model 
(IIM) format. This metadata can optionally be extracted into an IpctIimAnn 
sub-annotation, which appears as a sub-annotation of your main annotation. In 
order to create an IpctIimAnn sub-annotation, perform the following operations:

1. From the Edit menu, select Preferences and click the Parsers tab.

The Parsers tab of the Preferences window appears (Figure 2–3).

2. Select JpgParser and select to create the IpctIimAnn sub-annotation.

3. Click OK to confirm and save the changes.

3.2 Editing Attribute Values
You can edit the value that appears for each attribute by performing the following 
operations:

1. Double-click the text in the right-hand column of the attribute.

A solid outline will appear around the table cell and an I-beam cursor will 
appear.

2. Edit the text.
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You can save your changes to the annotation. See Section 3.6 for more information.

3.3 Adding and Deleting Attributes to the Annotation
interMedia Annotator defines a given number of attributes (see Appendix B for a 
complete list of attributes). However, not all media sources will provide values for 
every attribute. You can use interMedia Annotator to add a value to your annotation 
for any attribute that does not have a value.

interMedia Annotator cannot write any new attribute values back to the media 
sources. The current annotation will contain the value, but any annotations created 
later by interMedia Annotator will not contain the new value.

To add a value for an attribute that has not been automatically set, perform the 
following operations:

1. From the Annotation menu, select Add Attribute.

The Add Attribute submenu appears (Figure 3–4).

Figure 3–4 Add Attribute Submenu

2. Select an attribute from the Add Attribute submenu.

Note: interMedia Annotator cannot change the attribute values in 
the media itself; it can only change the attribute values in the 
extracted annotation. If you parse the media file again, your 
annotation will be overwritten and any attributes that you have 
edited will revert back to their original values.
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The new attribute appears in the Attributes tab with no value in the right-hand 
column.

3. Enter a value in the right-hand column.

Validation of type is done at this time.

To delete an attribute from your annotation, perform the following operations:

1. Select the attribute to delete.

2. From the Annotation menu, select Delete Attribute.

The Please Confirm window appears (Figure 3–5).

Figure 3–5 Please Confirm Window for Deleting Attributes

3. Click Yes.

The attribute and its value are deleted from the annotation.

3.4 Adding and Deleting Annotations
An annotation will usually contain one or more sub-annotations, which contain the 
metadata associated with a portion of the media source, such as a text track or an 
audio track. In addition to these populated sub-annotations, you can create your 
own sub-annotations by adding an empty annotation and then populating it with 
your own values.

To create an empty annotation, perform the following operations:

1. Select the annotation under which you will add a sub-annotation.

2. From the Attribute menu, select Add Annotation.

The Add Annotation submenu appears (Figure 3–6).
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Figure 3–6 Add Annotation Submenu

3. Select the type of annotation to create.

Your new annotation appears in the Annotation Tree View.

You can populate an empty annotation with attribute values in the same way you 
would add attribute values to a populated annotation. See Section 3.3 for more 
information.

You can also delete sub-annotations from an annotation. You can delete 
sub-annotations that you have created and sub-annotations that were created 
automatically in the parsing process. To delete an annotation, perform the following 
operations:

1. Select the annotation to be deleted.

2. From the Attribute menu, select Delete Annotation.

The Please Confirm window opens (Figure 3–7).
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Figure 3–7 Please Confirm Window for Deleting Annotations

3. Click Yes.

The selected sub-annotation is removed from the Annotation Tree View.

3.5 Extracting a Sample
You can use interMedia Annotator to extract three types of samples: text selections 
(or tracks) from a QuickTime movie file, images from a QuickTime movie file, audio 
tracks from a compact disc.

3.5.1 Text Tracks from QuickTime Movies
To extract a text track from a QuickTime movie, perform the following operations:

1. Annotate a QuickTime movie that contains a text track, such as oracle_
comm2.mov (included with interMedia Annotator). See Section 3.1 for more 
information on creating an annotation.

2. Select TextAnn in the left-hand window pane.

3. Either select Extract Samples from the Annotation menu or click the Extract 
Samples button on the toolbar.

View the extracted text information by clicking the Samples tab when the text 
annotation is selected (Figure 3–8).
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Figure 3–8 Samples Tab with Audio Samples

3.5.2 Video Tracks from a QuickTime Movie
To extract a video track from a QuickTime movie, perform the following operations:

1. Annotate a QuickTime movie. See Section 3.1 for more information on creating 
an annotation.

2. Select VideoAnn in the left-hand window pane.

3. Set the amount of video data to be extracted by performing the following steps:

a. From the Edit menu, select Preferences and click the Parsers tab.

The Parsers tab of the Preferences window appears (Figure 2–3).

b. Click the plus sign (+) next to the QT4JavaParser option.

c. In the list that appears, select ExtractVideoSamples.

d. If you want to specify the time interval to pass between frame extractions, 
then enter "true" in the "Extraction by Time Interval" field and enter the 
interval (in seconds) in the "Extraction Parameter" field.

e. If you want to specify the number of frames to be extracted, then enter 
"false" in the "Extraction by Time Interval" field and enter the number of 
frames to be extracted in the "Extraction Parameter" field.

f. Click OK to confirm and save the changes.

4. Either select Extract Samples from the Annotation menu or click the Extract 
Samples button on the toolbar.

View the extracted video information by clicking the Samples tab when the video 
annotation is selected (Figure 3–9).
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Figure 3–9 Samples Tab with Video Samples

3.5.3 Audio Tracks from a CD
interMedia Annotator can extract audio data from a CD track. You can specify the 
start and end points of your extracted sample.

To extract samples from a CD, perform the following operations:

1. Annotate an audio CD. See Section 3.1 for more information on creating an 
annotation.

2. Select an audio CD track annotation in the Annotations pane.

3. Set the amount of audio data to be extracted by performing the following steps:

a. From the Edit menu, select Preferences and click the Parsers tab.

The Parsers tab of the Preferences window appears (Figure 2–3).

b. Click the plus sign (+) next to the Audio CD Parser option.

c. In the list that appears, select ExtractAudioClipTrack.

d. In the "Audio Sample Start Time" field, enter the time in seconds from 
which you want to start extracting.

e. In the "Audio Sample Length" field, enter the duration of the sample to be 
extracted, in seconds.

f. Click OK to confirm and save the changes.
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4. Click the Extract Media Samples button on the toolbar.

The audio sample is extracted and stored in the Sun AU sound file format.

After extraction, media source attributes will be modified in order to refer to the 
extracted sample. These attributes include file format, MIME type, file name, 
directory, and URL, among others.

See Section 3.8 for more information on playing back the extracted sample.

3.6 Saving Annotations
Once you have parsed a media source, you can save the annotation as an XML 
document by performing the following operations:

1. From the File menu, select Save.

The Save window appears (Figure 3–10).

Figure 3–10 Save Window

2. Enter a file name in the "File name: " field and click Save.
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The XML document can be viewed through any text editor or through interMedia 
Annotator. See Section 3.7 for more information.

The default folder where interMedia Annotator will save annotations is set in the 
General tab of the Preferences window. To change the default folder, perform the 
following operations:

1. From the Edit menu, select Preferences and click the General tab. The General 
tab of the Preferences window appears (Figure 2–2).

2. Enter the name of the new default folder in the "Open/Save Directory: " text 
field.

3. Click OK to confirm and save the changes.

3.7 Opening a Saved Annotation
If you have a saved annotation, you can open it in interMedia Annotator by 
performing the following operations:

1. Either click the Open button on the toolbar or select Open from the File menu.

The Make a Selection window appears (Figure 3–11).

Figure 3–11 Make a Selection Window

2. Click the Browse button.

The Open window appears (Figure 3–2).

Note: interMedia Annotator does not automatically append the 
suffix .xml to the provided file name. You must manually enter the 
suffix.
3-12 Oracle interMedia Annotator User’s Guide



Playing Media Sources or Viewing Extracted Samples
3. Select an annotation file and click Open.

The annotation and its sub-annotations appear in the Annotation Tree View.

3.8 Playing Media Sources or Viewing Extracted Samples
You can use interMedia Annotator to play your media source and any text or video 
sample that you have extracted.

Before playing a media source or sample, check the Mime-Types tab of the 
Preferences window to ensure that each MIME type is paired with the correct path 
to the appropriate helper application. See Section 2.3.5 for more information.

3.8.1 Media Source
Play a media source or an extracted sample by performing the following operations:

1. Select the annotation at the root of the Annotation Tree View.

2. Either click the Play Source button on the Annotation toolbar or select Play 
Source from the Annotation menu.

The appropriate media player opens and plays the media source.

3.8.2 Media Sample
Play an extracted media sample by performing the following operations:

1. Extract a media sample. See Section 3.5 for more information.

2. Select the sub-annotation associated with the sample you want to play.

3. Either click the Play Source button on the Annotation toolbar or select Play 
Source from the Annotation menu.

The appropriate media player opens and plays the media source.

3.8.3 Text Sample
You can view a text sample without opening a separate viewer.

After extracting the text sample, click the Samples tab in the right-hand window 
pane. The text sample appears, along with a timeline indicating roughly where each 
piece of text appears in the video or song.
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Creating New Annotation Types

In addition to the supplied annotation types, you can use interMedia Annotator to 
create your own annotation types in order to better meet the needs of your 
applications. For example, the owner of an online sales database can define 
annotations containing inventory and price information alongside the media data 
and the extracted metadata.

For a complete example of a user-defined annotation type, see ANNOTATOR_
HOME\demo\examples\SampleInventoryAnn.xml.

4.1 Writing a New Annotation Type
You define a new annotation type in an XML file. The XML file must follow the 
AnnotationDescriptor DTD, found at ANNOTATOR_
HOME\lib\descriptors\annotation\AnnotationDescriptor.dtd.

When you finish writing the XML file, you should save it to ANNOTATOR_
HOME\lib\descriptors\annotations.

The DTD describes the AnnotationDescriptor DTD, which contains two elements: 
AnnotationProperties and AttributeDescriptors.

4.1.1 AnnotationProperties Element
The AnnotationProperties element contains elements that provide information 
about the annotation as a whole. The elements contained are Name, Version, 
Description, Extends, Contains, ClassName, and IconFileName.

Name and Version are required elements. They contain the name of the new 
annotation type and the version number, respectively.
ypes 4-1



Writing a New Annotation Type
Description is an optional element that contains a brief description of the annotation 
as a whole.

Extends is an optional element. It contains the name of another annotation type, 
which your new annotation type will extend; that is, your new annotation type will 
include all the attribute definitions from the given annotation type, as well as any 
additional attributes that you define. However, you cannot overwrite the attributes 
that are inherited from the existing annotation type; you can only create new 
attributes. If you want to create an annotation type that is not related to another 
annotation type, do not include the Extends element.

Contains, ClassName, and IconFileName are reserved elements; do not assign 
values to these elements.

4.1.2 AttributeDescriptors Element
The AttributeDescriptors element contains one or more AttributeDescriptor 
elements. An AttributeDescriptor element contains one AttributeProperties 
element.

An AttributeProperties element contains elements that provide information about 
the specific attributes of your new annotation type. The elements contained are 
AttributeName, AttributeType, AttributeTypePattern, AttributeAlias, 
AttributeDescription, and AttributeDefaultValue.

AttributeName is a required element that contains the name of your new attribute.

AttributeType is a required element that contains the Java object type of the 
attribute value. AttributeType must be a Java object type; Java primitives are not 
allowed in your XML document. For example, if you want to use an integer, do not 
use "int", but rather "java.lang.Integer".

Almost any Java object type can be used as the AttributeType, as long as the Java 
object type defines two valid methods: public String toString( ) and public static 
Object valueOf(String), where Object is the Java object type. These methods return 
the contents of the object as a valid String and returns the contents of a given String 
as a valid object of type Object, respectively.

The class java.util.Date is a special case; it does not use the previous methods to 
provide a String representation of the contents of the object. Instead, use the 
AttributeTypePattern element. This element (which should be used only if the 
AttributeType is java.lang.Date) specifies the String pattern that should be used 
when displaying the date. The pattern follows the syntax in 
java.text.SimpleDateFormat. AttributeTypePattern is an optional element.
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AttributeAlias, AttributeDescription, and AttributeDefaultValue are optional 
elements that define a shorter attribute name for display purposes, a short 
description of the attribute, and the default value of the attribute to be inserted in 
the annotation, respectively.

4.1.3 Element Hierarchy
In general, the structure of your XML document should be similar to the following:

<?xml version="1.0">
<!DOCTYPE AnnotationDescriptor SYSTEM "AnnotationDescriptor.dtd>
<AnnotationDescriptor>
   <AnnotationProperties>
      <Name>...</Name>
      <Version>...</Version>
      <Description>...</Description>
      <Extends>...</Extends>
   </AnnotationProperties>
   <AttributeDescriptors>
      <AttributeDescriptor>
         <AttributeProperties>
            <AttributeName>...</AttributeName>
            <AttributeType>...</AttributeType>
            <AttributeTypePattern>...</AttributeTypePattern>
            <AttributeAlias>...</AttributeAlias>
            <AttributeDescription>...</AttributeDescription>
            <AttributeDefaultValue>...</AttributeDefaultValue>
         </AttributeProperties>
      </AttributeDescriptor>
      <AttributeDescriptor>
      .
      .
      .
      </AttributeDescriptor>
   </AttributeDescriptors>
</AnnotationDescriptor>

4.2 Using a New Annotation Type
Once you have written your new XML file and included it in the ANNOTATOR_
HOME\lib\descriptors\annotations directory, you will be able to use your new 
annotation type in the same way that you use the predefined annotation types. See 
Section 3.1 and Section 3.4 for more information on creating new annotations.
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Note: An XML file is space-sensitive; "java.lang.Double" is valid, 
while "java.lang.Double  " is invalid. Be careful that your XML file 
does not contain extraneous spaces because it could lead to errors.
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Uploading Structured Annotations into a

Database

interMedia Annotator can upload media data and an associated annotation into an 
Oracle8i database where Oracle8i interMedia has been installed. It does so through 
an Oracle PL/SQL Upload Template, which contains both PL/SQL calls and 
Annotator-specific keywords.

You create your own PL/SQL Upload Templates. Advanced users with PL/SQL 
experience can write PL/SQL Upload Templates in a text editor. See Section 5.1 for 
more information. Novice users can use the PL/SQL Template Wizard, which is a 
graphical user interface that progresses through each step of PL/SQL Upload 
Template creation. See Section 5.2 for more information.

Before proceeding, please read Steps 1 and 2 of Section 2.3.1 in order to configure 
the preferences for your database connection.

5.1 Creating Upload Templates Manually
Experienced interMedia Annotator users with experience in PL/SQL and JDBC may 
want to create their own PL/SQL Upload Templates instead of using the PL/SQL 
Template Wizard. You can create a PL/SQL Upload Template using any text editor.

5.1.1 Structure of Upload Templates
The PL/SQL Upload Template begins with a list of DML and DDL statements. This 
list is optional, depending on your needs.

Following this list is one anonymous PL/SQL block. You cannot have more than 
one anonymous PL/SQL block, and nothing should appear in the PL/SQL Upload 
Template after you end the block.
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The anonymous PL/SQL block contains both standard PL/SQL code and 
interMedia Annotator-specific keywords. For more information on the keywords, 
see Section 5.1.2. For more information on writing PL/SQL code, see PL/SQL User’s 
Guide and Reference.

Depending on the platform of the database server, there is a limit on the maximum 
size of the anonymous PL/SQL block. If you encounter this problem, you can work 
around it by packaging some of your statements into PL/SQL procedures in order 
to reduce the size of your PL/SQL block.

5.1.2 Annotator-Specific Keywords
In addition to standard PL/SQL calls, the PL/SQL Upload Templates contain 
Annotator-specific keywords. The keywords are delimited by ${ and }. These 
keywords are interpreted by the Annotator preprocessor, which interprets the 
keywords and generates the appropriate PL/SQL code.

The following sections provide more information on the keywords.

5.1.2.1 Attribute Values
Instead of hard-coding values for specific attributes in your PL/SQL Upload 
Template, you provide the name of the attribute, enclosed with the ${ and } 
characters. This tells the preprocessor to get the actual value of the attribute from 
the current annotation and use that value to replace the keyword in the PL/SQL 
Upload Template. This simple replacement allows you to use the same PL/SQL 
Upload Template for multiple annotations.

Example 5–1 shows keywords that will later be replaced with attribute values.

Example 5–1 Attribute Values as Keywords

audioObj.setMimeType(’${MEDIA_SOURCE_MIME_TYPE}’);
INSERT INTO SongsTable VALUES(’${AUDIO_CD_TRACK_CDID}’);

Note: An Annotator-specific keyword must appear on its own line 
in the PL/SQL Upload Template. You cannot have multiple 
keywords on the same line.
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5.1.2.2 ${MANN_BEGIN_ITERATE} and ${MANN_END_ITERATE}
The ${MANN_BEGIN_ITERATE} and ${MANN_END_ITERATE} keywords 
indicate that the code enclosed by the keywords should be repeated for each 
sub-annotation of the given type. The name of the annotation type follows the 
${MANN_BEGIN_ITERATE} keyword.

Example 5–2 shows a block of code that will be run for each AudioCDTrackAnn 
that exists as a sub-annotation of the current annotation.

Example 5–2 ${MANN_BEGIN_ITERATE} and ${MANN_END_ITERATE}

${MANN_BEGIN_ITERATE} AudioCDTrackAnn
INSERT INTO SongsTable VALUES(’${AUDIO_CD_TRACK_CDID}’,
                              ’${AUDIO_CD_TRACK_ID}’);
${MANN_END_ITERATE}

5.1.2.3 ${MANN_BEGIN_TRACK} and ${MANN_END_TRACK}
The ${MANN_BEGIN_TRACK} and ${MANN_END_TRACK} keywords indicate 
that the code enclosed by the keywords should be run on the first instance of a 
sub-annotation of the given class. The name of the annotation type follows the 
${MANN_BEGIN_TRACK} keyword.

Example 5–3 shows a block of code that will be run upon the first 
AudioCDTrackAnn that exists as a sub-annotation of the current annotation.

Example 5–3 ${MANN_BEGIN_TRACK} and ${MANN_END_TRACK}

${MANN_BEGIN_TRACK} AudioCDTrackAnn
INSERT INTO SongsTable VALUES(’${AUDIO_CD_TRACK_CDID}’,
                              ’${AUDIO_CD_TRACK_ID}’);
${MANN_END_TRACK}

5.1.2.4 ${MANN_BEGIN_IFDEF} and ${MANN_END_IFDEF}
The ${MANN_BEGIN_IFDEF} and ${MANN_END_IFDEF} keywords indicate that 
the code enclosed by the keywords should be run only if the current annotation has 
a defined value for a given attribute. The name of the attribute follows the 
${MANN_BEGIN_IFDEF} keyword.

Example 5–4 shows a block of code that will be run only if the MEDIA_SOURCE_
MIME_TYPE attribute is defined in the current annotation.
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Example 5–4 ${MANN_BEGIN_IFDEF} and ${MANN_END_IFDEF}

${MANN_BEGIN_IFDEF} MEDIA_SOURCE_MIME_TYPE
audioObj.setMimeType(’${MEDIA_SOURCE_MIME_TYPE}’);
${MANN_END_IFDEF}

5.1.2.5 ${MANN_BEGIN_IFEQUALS} and ${MANN_END_IFEQUALS}
The ${MANN_BEGIN_IFEQUALS} and ${MANN_END_IFEQUALS} keywords 
indicate that the code enclosed by the keywords should be run only if the current 
annotation contains a given attribute of a given value. The name of the attribute and 
the value follow the ${MANN_BEGIN_IFEQUALS} keyword. The string 
comparison is case-sensitive.

Example 5–5 shows a block of code that will be run only if the MEDIA_SOURCE_
MIME_TYPE attribute is defined as audio/basic in the current annotation.

Example 5–5 ${MANN_BEGIN_IFEQUALS} and ${MANN_END_IFEQUALS}

${MANN_BEGIN_IFEQUALS} MEDIA_SOURCE_MIME_TYPE audio/basic
audioObj.setMimeType(’${MEDIA_SOURCE_MIME_TYPE}’);
${MANN_END_IFEQUALS}

5.1.2.6 ${MANN_UPLOAD_SRC}
The ${MANN_UPLOAD_SRC} keyword indicates that the media source data 
associated with the current annotation should be uploaded to the current Oracle8i 
database table using JDBC; the file is loaded into Annotator, and Annotator loads 
the file into the database. The name of the server-side object and attribute (of the 
BLOB type) follows the ${MANN_UPLOAD_SRC} keyword.

Upload performance with the ${MANN_UPLOAD_SRC} keyword may be slow if 
you are using the JDBC Thin driver to upload a large media source, or if you have a 
slow network connection. You may get better results by using the interMedia 
import( ) method. See Section 5.2.1 for more information on the differences between 
the two upload options. See Oracle8i interMedia Audio, Image, and Video User’s Guide 
and Reference for more information on the import( ) method.

Example 5–6 shows a block of code that will upload the current media source data 
to the source.localData attribute of the server-side interMedia object videoObj.

Example 5–6 ${MANN_UPLOAD_SRC}

${MANN_UPLOAD_SRC} videoObj.source.localData
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5.1.2.7 ${MANN_UPLOAD_XML}
The ${MANN_UPLOAD_XML} keyword indicates that the current annotation 
should be uploaded to the current Oracle8i database table. The annotation should 
be uploaded to a CLOB in an Oracle8i interMedia object. The name of the 
server-side object and CLOB attribute follows the ${MANN_UPLOAD_XML} 
keyword.

Example 5–7 shows a block of code that will upload the current annotation to the 
comments attribute of the server-side interMedia object videoObj.

Example 5–7 ${MANN_UPLOAD_XML}

${MANN_UPLOAD_XML} videoObj.comments

For more information on Oracle8i interMedia APIs, see Oracle8i interMedia Audio, 
Image, and Video User’s Guide and Reference

5.1.3 Saved Files
Once you have written your PL/SQL Upload Template, save it with the suffix .ofm. 
The default folder that Annotator uses for PL/SQL Upload Templates is 
ANNOTATOR_HOME\ofm. To change the default folder, see Section 5.2.6.

See Section 5.4 for information on how to run a PL/SQL Upload Template.

5.1.4 Complete PL/SQL Upload Template Example
Example 5–8 contains a sample PL/SQL Upload Template. It will upload a video 
object and its associated annotation to an Oracle8i table named MediaTable. The 
sample contains one anonymous PL/SQL block containing a mix of PL/SQL calls 
and Annotator-specific keywords.

Example 5–8 PL/SQL Upload Template Sample

DECLARE
   videoObj       ORDSYS.ORDVIDEO;
   ctx            RAW(4000) := NULL;
BEGIN
   INSERT INTO MediaTable VALUES (
      1,
      ORDSYS.ORDVIDEO(
         ’${MEDIA_TITLE}’,
         ORDSYS.ORDSource(EMPTY_BLOB(),
            NULL,
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            ’${MEDIA_SOURCE_DIRECTORY}’,
            ’${MEDIA_SOURCE_FILENAME}’,
            NULL,NULL),
         ’${MEDIA_SOURCE_FILE_FORMAT}’,
         ’${MEDIA_SOURCE_MIME_TYPE}’,
         EMPTY_CLOB(), NULL, NULL, NULL, NULL, NULL, NULL, ’’,
         NULL, NULL)
   );

   SELECT M.mediaSource INTO videoObj 
   FROM   MediaTable M
   WHERE  M.MediaId = 1
   FOR UPDATE;

   ${MANN_UPLOAD_SRC} videoObj.source.localData
   ${MANN_UPLOAD_XML} videoObj.comments

   UPDATE MediaTable M SET M.mediaSource = videoObj
   WHERE  M.mediaId = 1;

END;

5.2 Using the PL/SQL Template Wizard to Generate Upload Templates
Users with limited PL/SQL experience should use the PL/SQL Template Wizard to 
generate a PL/SQL Upload Template. The PL/SQL Template Wizard takes you 
through a step-by-step process to create a PL/SQL Upload Template through a 
graphical user interface; you do not need to understand the Annotator-specific 
keywords involved.

To start the PL/SQL Template Wizard, perform one of the following operations:

■ Click the Generate Template button on the Oracle toolbar (Figure 1–5).

■ From the Database menu, select PL/SQL Template Wizard.

The following sections go through each screen of the PL/SQL Template Wizard.

5.2.1 Upload Method
The Upload Method window (Figure 5–1) asks you to specify a method to upload 
the media source.
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Figure 5–1 PL/SQL Template Wizard Upload Method Window

There are two different methods that Annotator can use to upload the media source 
and annotation to your database: import and remote. In an import upload, the 
media source must be visible to the database server (either in a file system or 
through an HTTP stream), and the media source will be loaded directly from the file 
system to the database. In a remote upload, the media source does not have to be 
visible to the database; the file is loaded into Annotator, and Annotator loads the 
file into the database through JDBC calls.

An import upload uses the Oracle interMedia import( ) method, while the remote 
upload uses the ${MANN_UPLOAD_SRC} Annotator-specific keyword.

If you select Import and the media source is in a file system, you must specify the 
path to the directory where the media file resides. The directory path should be 
specified from the point of view of the Oracle8i database server to which you are 
uploading. For example, if you are running interMedia Annotator on Windows NT 
and you want to upload data to an Oracle8i database that is running on a UNIX 
platform, the media data must reside in a directory that can be accessed by both 
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machines. You can do this by mounting a UNIX directory on the server into a 
Windows NT network drive. Prior to entering the PL/SQL Template Wizard, you 
would refer to the media file using the mapped Windows drive/directory name. In 
the PL/SQL Template Wizard, however, you must specify the directory using the 
UNIX directory name that Oracle8i will use to access the media.

If you select Import and the media source is an HTTP stream, you can choose to 
either import the media data into the database or store the URL in the database.

If you select Remote and you are using the JDBC Thin driver, your upload 
performance may be poor, especially if you are uploading large files.

5.2.2 Table Selection
The Table Selection window (Figure 5–2) asks you to choose the table into which 
the interMedia object will be uploaded.

Figure 5–2 PL/SQL Template Wizard Table Selection Window
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This table must have at least one column of the appropriate interMedia object type 
(ORDSYS.ORDAudio for annotations for audio files or songs from a CD, 
ORDSYS.ORDImage for annotations for image files, or ORDSYS.ORDVideo for 
annotations for video files) in order to proceed. The PL/SQL Template Wizard will 
check for this condition and notify you if it is not met.

5.2.3 Upload Details
The Upload Details window (Figure 5–3) asks if you want to upload the object into 
an existing row of the table or into a new row.

Figure 5–3 PL/SQL Template Wizard Upload Details Window

If you choose No, you will be taken to the Row Selection window. See Section 5.2.5 
for more information.
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If you choose Yes, you have to specify a value for each table column. This is 
necessary for the primary keys, which will be marked with an asterisk. For the 
remaining columns, you are given several possible input methods:

■ Use the default values provided by interMedia Annotator.

■ Manually fill in the values, observing the usual SQL syntax according to the 
column type.

■ From the pull-down menu, choose an attribute of the annotation that you are 
inserting. interMedia Annotator will insert the value of this attribute into the 
new row. This option is recommended if you want to build an index on a 
specific column representing an annotation attribute.

Figure 5–3 shows the ID column (primary key) having its value manually typed in, 
the VSRC column (ORDSYS.ORDVideo) using the default value provided by 
interMedia Annotator, and the TITLE column being mapped to the annotation’s 
MEDIA_TITLE attribute.

If your table has multiple columns containing interMedia objects, clicking the Next 
button will take you to the Column Selection window. See Section 5.2.4 for more 
information.

If you are uploading to an existing row, clicking the Next button will take you to the 
Row Selection window. See Section 5.2.5 for more information.

If your table has only one column of interMedia objects and you are uploading to a 
new row, the Generate button will be enabled. See Section 5.2.6 for more 
information.

5.2.4 Column Selection
The media data and the annotation in XML form will be uploaded only to a table 
that contains an interMedia object whose type can be mapped to the annotation. If 
your table contains two or more such columns, the Column Selection window 
(Figure 5–4) will prompt you to select the column into which the interMedia object 
will be uploaded.
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Figure 5–4 PL/SQL Template Wizard Column Selection Window

If you previously chose to insert a new row, the Generate button is enabled after 
you select a column. See Section 5.2.6 for more information.

If you previously chose to upload to an existing row, the Next button will take you 
to the Row Selection window. See Section 5.2.5 for more information.

5.2.5 Row Selection
The Row Selection window (Figure 5–5) asks you to enter the criteria to be used for 
querying a row that contains the column into which the interMedia object will be 
uploaded.
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Figure 5–5 PL/SQL Template Wizard Row Selection Window

The table name was specified earlier, so you need to specify the WHERE clause of a 
SQL SELECT statement that will return the interMedia destination object. You can 
use the Count button to ensure that only one row is returned.

Once you complete this step, the Generate button is enabled. See Section 5.2.6 for 
more information.

5.2.6 Generate
When you have entered all the necessary information, the Generate button will 
become active. Click the Generate button to close the PL/SQL Template Wizard and 
generate your PL/SQL Upload Template. Possible SQL errors will be reported 
through the Console.

Your PL/SQL Upload Template will be saved to a default directory that is defined 
in the Preferences window. Initially, the directory is set to ANNOTATOR_
HOME\ofm. To change this folder, perform the following operations:
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1. From the Edit menu, select Preferences and click the General tab. The General 
tab of the Preferences window appears (Figure 2–2).

2. Perform one of the following operations:

■ Enter the path to the new folder in the "PL/SQL Template Folder" field.

■ Click the Browse button next to the "PL/SQL Template Folder" and select 
the new folder in the dialog box.

3. Click OK to apply and save the changes.

See Section 5.4 for information on how to run a PL/SQL Upload Template.

5.3 Editing Existing PL/SQL Upload Templates
Whether you use the PL/SQL Template Wizard or you write your own PL/SQL 
Upload Templates from scratch, you can edit your PL/SQL Upload Templates in a 
text editor.

You cannot use the PL/SQL Template Wizard to edit an existing PL/SQL Upload 
Template; it can create only new PL/SQL Upload Templates.

5.4 Using Upload Templates to Upload to the Database
If you use the PL/SQL Template Wizard or a text editor to create a new PL/SQL 
Upload Template, or if you use one of the files provided with interMedia Annotator, 
you have to run the PL/SQL Upload Template from within interMedia Annotator in 
order to actually upload your media source and annotation to your database.

To run a PL/SQL Upload Template, perform the following operations:

1. Perform one of the following operations:

■ Click the Upload to Oracle button on the Oracle toolbar (Figure 1–5).

■ From the Database menu, select Upload.

The Upload Annotation window appears (Figure 5–6).
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Figure 5–6 Upload Annotation Window

2. Perform one of the following operations:

■ Enter the path to the new folder in the "PL/SQL Template Folder" field.

■ Click the Browse button, select the new folder in the dialog box, and click 
Open.

3. Click OK to run the PL/SQL Upload Template.

Errors encountered during the upload process will appear in the Console.
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Querying Stored Annotations

After the media data and the annotation are uploaded into an Oracle8i database, 
you can use interMedia Text to perform a query on the annotation (which is saved 
in the database in XML form).

The following PL/SQL code excerpt is an example of how to build an interMedia 
Text index on the VideoStorage table. This code excerpt generates an interMedia 
Text index on the comments field of the vsrc column of the VideoStorage table, with 
the defined list preference, as well as the XML tags, defined in the section group:

-- create a preference
execute ctx_ddl.create_preference(’ANNOT_WORDLIST’, ’BASIC_WORDLIST’);
execute ctx_ddl.set_attribute(’ANNOT_WORDLIST’, ’stemmer’, ’ENGLISH’);
execute ctx_ddl.set_attribute(’ANNOT_WORDLIST’, ’fuzzy_match’, ’ENGLISH’);
...

-- section group
execute ctx_ddl.create_section_group(’MOVIEANN_TAGS’,
                                     ’xml_section_group’);
execute ctx_ddl.add_zone_section(’MOVIEANN_TAGS’, ’MOVIECASTTAG’,
                                 ’MOVIE_CAST’);
execute ctx_ddl.add_zone_section(’MOVIEANN_TAGS’,
                                 ’MEDIACOPYRIGHTTAG’,
                                 ’MEDIA_COPYRIGHT’);
execute ctx_ddl.add_zone_section(’MOVIEANN_TAGS’, 
                                 ’MEDIASOURCEFILEFORMATTAG’,
                                 ’MEDIA_SOURCE_FILE_FORMAT’);
...
CREATE INDEX videoIdx ON VideoStorage(vsrc.comments) INDEXTYPE IS 
     CTXSYS.CONTEXT PARAMETERS(’stoplist CTXSYS.EMPTY_STOPLIST wordlist 
     ANN_WORDLIST filter CTXSYS.NULL_FILTER section group MOVIEANN_TAGS’);

See Section 2.3.2 for more information on creating the VideoStorage table.
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The following PL/SQL code excerpt is an example of how to query the 
VideoStorage table:

-- Peform a query
select id, score(99)
from VideoStorage V
where
     CONTAINS(V.vsrc.comments, ’(John Doe) WITHIN MOVIECASTTAG’,
     99) > 0;

The preceding query returns the clip identification number and the relevancy score 
(generated by interMedia Text) of the video clips that contain "John Doe" in the 
MOVIE_CAST attribute of the associated annotation.

A copy of the preceding PL/SQL statements is available in: ANNOTATOR_
HOME\demo\examples\SampleCode.sql

For more information, see Oracle8i interMedia Text Reference.
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Supported Formats

interMedia Annotator supports the following file formats:

■ Apple QuickTime 4.0

■ Microsoft AVI

■ AIFF/AIFC

■ AU

■ WAV

■ Audio MPEG I/II, all layers

■ RealMedia

■ Audio compact disc

■ JPEG/JFIF

■ GIF87a/GIF89a

■ BMP

■ TIFF

Table A–1 shows the media source formats that have built-in support from 
interMedia Annotator and what, if any, extraction capabilities are offered by the 
corresponding built-in parser.

Table A–1 Built-in Parsers

File Format MIME type Extraction

Apple QuickTime 4.0 video/quicktime Text track

Video frame
mats A-1



RIFF video/x-msvideo

application/x-troff-msvideo

audio/x-wav

None

AIFF audio/x-aiff

audio/x-aif

None

RealMedia video/x-realvideo

video/x-realaudio

None

Sun Audio audio/basic None

MPEG I/II Audio audio/x-mpeg None

Audio CD audio/x-cd-cdda Audio sample

JPEG/JFIF image/jpeg

image/jpg

None

GIF image/gif None

BMP image/bmp None

TIFF image/tiff None

Table A–1 Built-in Parsers(Cont.)

File Format MIME type Extraction
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Defined Annotation Attributes

The tables in this appendix show the defined annotation attributes that are included 
with interMedia Annotator.

Table B–1 MediaAnn Codes

Attribute Description

MEDIA_TITLE Title of the media

MEDIA_DESCRIPTION Description of the media

MEDIA_INFORMATION Information on the media

MEDIA_COPYRIGHT Copyright information of the media

MEDIA_PRODUCER Producer of the media

MEDIA_DURATION Duration of the media, in the form 
hour:minute:second:mantissa, where 
mantissa is the fraction of a second in the 
units defined in MEDIA_TIMESCALE

MEDIA_TRACK_ID Track identifier for the annotation

MEDIA_TIMESCALE Number of units in a second

MEDIA_CONTENT_DATE Creation date of the media content

MEDIA_MODIFICATION_TIME Modification time of type java.util.Date

MEDIA_CREDITS Credits for content providers

MEDIA_SIZE Size of the media source, in bytes

MEDIA_FORMAT_ENCODING_CODE Short form (four characters) of the media 
encoding

MEDIA_FORMAT_ENCODING Format of the media encoding
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MEDIA_USER_DATA String containing miscellaneous user data

MEDIA_LANGUAGE Language of the media

MEDIA_BITRATE Bit rate of the media (in bits/second)

MEDIA_CATEGORY Media category or genre

MEDIA_AUTHORING_TOOL Authoring tool used to create the media

MEDIA_SOURCE_URL Location or URL of the parsed media source

MEDIA_SOURCE_PROTOCOL URL protocol of the media source

MEDIA_SOURCE_MIME_TYPE MIME type of the media and its samples

MEDIA_SOURCE_DIRECTORY Directory where the source is stored

MEDIA_SOURCE_FILENAME File name of the source

MEDIA_SOURCE_FILE_FORMAT Media file format

MEDIA_SOURCE_FILE_FORMAT_CODE Short form (four characters) of media file 
format

MEDIA_SOURCE_STREAMABLE The streaming server that the media is 
optimized for, if any

Table B–2 AudioAnn Codes (extends MediaAnn)

Attribute Description

AUDIO_BITS_PER_SAMPLE Number of bits per sound sample

AUDIO_SAMPLE_RATE Audio sampling rate (in samples/second)

AUDIO_NUM_CHANNELS Number of audio channels

AUDIO_ARTIST Main artist for the audio clip

Table B–3 VideoAnn Codes (extends MediaAnn)

Attribute Description

VIDEO_FRAME_RATE Video frame rate (in frames/second)

VIDEO_FRAME_SIZE Video frame size (in bytes)

VIDEO_SRC_HEIGHT Video height (in pixels)

Table B–1 MediaAnn Codes(Cont.)

Attribute Description
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VIDEO_SRC_WIDTH Video width (in pixels)

VIDEO_HORIZONTAL_RES Horizontal resolution (in pixels/inch)

VIDEO_VERTICAL_RES Vertical resolution (in pixels/inch)

VIDEO_IS_GRAYSCALE Whether or not the video has colors

VIDEO_DEPTH Number of bits for the color depth

Table B–4 TextAnn Codes (extends MediaAnn)

Attribute Description

TEXT_FONTSIZE Point size of the text track

TEXT_FONTFACE Font styles used (such as italics or boldface)

TEXT_FONTNAME Name of the font used

TEXT_BG_COLOR Background color (for example, 
0x00RRGGBB)

TEXT_FG_COLOR Foreground color (for example, 
0x00RRGGBB)

TEXT_ALIGN Left, center, right, or justified

TEXT_DEF_BOX Default text box size, consisting of four 
instances of the Java primitive type short

Table B–5 MovieAnn Codes (extends MediaAnn)

Attribute Description

MOVIE_DIRECTOR Director of the movie

MOVIE_CAST Names of the performers in the movie

MOVIE_EDIT_INFORMATION Information about the editing

MOVIE_WARNING Movie rating and warning information

Table B–3 VideoAnn Codes (extends MediaAnn)(Cont.)

Attribute Description
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Table B–6 AudioCDAnn Codes (extends MediaAnn)

Attribute Description

AUDIO_CD_ID CD identifier, recognized by CDDB

AUDIO_CD_NUM_OF_TRACKS Number of tracks on the CD

AUDIO_CD_ARTIST Main artist of the CD

Table B–7 AudioCDTrackAnn Codes (extends AudioAnn)

Attribute Description

AUDIO_CD_TRACK_MINUTE Starting minute of the track

AUDIO_CD_TRACK_SECOND Starting second of the track

AUDIO_CD_TRACK_FRAME Starting frame of the track

AUDIO_CD_TRACK_LBA Logical block address associated with the 
track

AUDIO_CD_TRACK_CDID CD identifier, recognized by CDDB

AUDIO_CD_TRACK_ALBUM Audio CD title

AUDIO_CD_TRACK_DURATION Duration of the track

Table B–8 ImageAnn Codes (extends MediaAnn)

Attribute Description

IMAGE_HEIGHT Height of the image

IMAGE_WIDTH Width of the image

IMAGE_COUNT Number of images stored in the file

IMAGE_PIXEL_FORMAT The color space of the image, including the 
resolution

IMAGE_BITS_PER_PIXEL Number of bits per image pixel

IMAGE_HORIZONTAL_RES Horizontal resolution (in pixels/inch)

IMAGE_VERTICAL_RES Vertical resolution (in pixels/inch)
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Table B–9 IptcIimAnn Codes

Attribute Description

IIM_RECORD_VERSION Version of the record

IIM_OBJECT_NAME Object name

IIM_SPECIAL_INSTRUCTION Special instructions

IIM_ACTION_ADVISED Action to be taken: either 01, 02, or 03

IIM_CREATION_DATE Creation date, consisting of the Date Created 
and Time Created record sets

IIM_DIGITAL_CREATION_DATE Date of creation of the digitized version, 
consisting of the Digital Creation Date and 
Digital Creation Time record sets

IIM_ORIGINATING_PROG Originating program

IIM_PROGRAM_VERSION Version of the originating program

IIM_OBJECT_CYCLE Either am (a), pm (p), or both (b)

IIM_BYLINE Creator of the image

IIM_BYLINE_TITLE Title of the creator of the image

IIM_CITY ID of the city of creation

IIM_SUB_LOCATION ID of the location within the city of creation

IIM_PROVINCE_STATE ID of the province or state of creation

IIM_COUNTRY_CODE ID of the country of creation

IIM_LOCATION_NAME Name of the location of creation

IIM_TRANSMISSION_REF Transmission reference

IIM_HEADLINE Headline associated with image

IIM_CREDIT Provider of the object

IIM_SOURCE Owner of the object

IIM_COPYRIGHT Copyright notice

IIM_CONTACT Contact for further information

IIM_CAPTION Caption or abstract

IIM_WRITER Writer or editor

IIM_IMAGE_TYPE Image type
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IIM_LANGUAGE Language ID

IIM_KEYWORDS Keywords associated with the image 
(supported with version 2 of IIM)

Table B–10 SampleAnn Codes (extends MediaAnn)

Attribute Description

SAMPLE_TIMESTAMP Time stamp of the specified sample, in the 
form hour:minute:second:mantissa, where 
mantissa is the fraction of a second in the 
units defined in MEDIA_TIMESCALE

Table B–11 TextSampleAnn Codes (extends SampleAnn)

Attribute Description

TEXTSAMPLE_VALUE String value of the text sample

Table B–12 VideoFrameSampleAnn Codes (extends SampleAnn)

Attribute Description

VIDEO_FRAME_SAMPLE_HEIGHT Height of the frame extracted from the video 
track

VIDEO_FRAME_SAMPLE_WIDTH Width of the video frame extracted from the 
video track

Table B–9 IptcIimAnn Codes(Cont.)

Attribute Description
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Frequently Asked Questions

How do I find out which attributes go with an annotation?
ANNOTATOR_HOME\lib\descriptors\annotations contains the XML files that 
define attributes for each annotation type.

Why won’t my media file load into the database?
■ The directory specified in the PL/SQL Upload Template is not accessible to the 

database server. This means that the directory does not exist or read access is 
not granted for that directory. See Section 5.2.1 for more details.

■ For the file being uploaded, there is no read access granted to the database 
server.

■ The INSERT statement in the PL/SQL Upload Template is incorrect. Refer to the 
reported SQL error in the Console for an indication of the problem. See 
Section 5.2.3 for more details.

■ If the media source is imported through an HTTP stream, an error may occur 
depending on your proxy settings. Make sure that the UTL_HTTP package in 
your Oracle8i database is correctly configured.

■ Either the specified WHERE clause returns no results or it returns more than 
one resulting row. See Section 5.2.5 for more details.

How do I build an index on an attribute value?
See Section 5.2.3.

How do I change the mapping between a file extension and its MIME type?
See Section 2.3.5.

When I am parsing a media source using the HTTP protocol, I encounter the 
following error: Unsupported Annotation for Content Type text/html
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Check the path of the URL pointing to the resource. It is possible that the URL is 
invalid.

In the Insert New Row window of the PL/SQL Template Wizard, why can’t I edit 
the values of the columns with interMedia Audio, Image, or Video type?

interMedia Annotator replaces the values of those columns with the media data and 
the annotation. Therefore, users are not expected to edit those columns, as their 
values will be overwritten automatically.

How can I change my startup settings?
If you are familiar with DOS batch files or UNIX shell scripts, you can modify the 
environment variables at the beginning of the startup script. 

When I run Annotator.bat on my Windows NT system, why do I see the 
following error: "Could not load runtime library: d:\JRE\bin\javai.dll"?

The error appears because the NT registry is not consistent with the JDK that is 
being used. The error can be corrected by reinstalling the JDK. Also, check the 
directory names in Annotator.bat.

Where can I find the latest information on interMedia Annotator?
The latest information, known problems, and FAQ are available at: 
http://technet.oracle.com/software/products/intermedia/
software_index.htm

On the Macintosh platform, where is the Oracle JDBC driver located?
A copy of the Oracle JDBC Thin driver version 8.1.5 is included with the Macintosh 
version of Annotator. It is located at ANNOTATOR_HOME\lib\classes111.zip.

Does QuickTime support include sprite track and flash track?
Sprite track and flash track are not supported.

How do I submit feedback on interMedia Annotator?
Please send email feedback to imedsup@us.oracle.com.
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